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Create and print labels for a mass mailing

Applies to: Microsoft Office Word 2007

When you want to use address labels to send a mass mailing to your address list, you can use mail merge to create a

sheet of address labels. Each label contains an address from your list.
The mail merge process entails the following overall steps:

Set up the labels. You set up the layout of the labels one time, for all the labels in the mail merge. In a
mail merge, the document that you use to do this is called the main document. In the label main document, you
can also set up any content that you want repeated on each label, such as a company logo or your return

address on shipping labels.

2. Connect the labels to your address list. Your address list is the data source that Microsoft Office Word

uses in the mail merge. It is a file that contains the addresses to be printed on the labels.

3. Refine the list of recipients. Word generates a label for each address in your mailing list. If you want to
generate labels for only certain addresses in your mailing list, you can choose which addresses, or records, to

include.

4. Add placeholders, called mail merge fields, to the labels. When you perform the mail merge, the mail

merge fields are filled with information from your address list.
5. Preview, complete the merge, and print the labels. You can preview each label before you print the whole
set.

You use commands on the Mailings tab to perform a mail merge.

TIP| You can also perform a mail merge by using the Mail Merge task pane, which leads you step by step through
the process. To use the task pane, in the Start Mail Merge group on the Mailings tab, click Start Mail Merge, and

then click Step by Step Mail Merge Wizard. In Step 1 of the process, under Select document type, click Labels.
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Chances are that you already have a package of label sheets from one of the label sheet suppliers, such as Avery,

AOne, or Formtec. Each sheet is a certain size and contains a certain number of labels with specific dimensions.

To set up the label main document, you need to match the dimensions of that document with the dimensions of the

labels on the sheets that you have on hand.

Start Word.

A blank document opens by default. Leave it open. If you close it, the commands in the next step are not
available.
On the Mailings tab, in the Start Mail Merge group, click Start Mail Merge.
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Click Labels.

In the Label Options dialog box, you have several choices to make.
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1 The type of printer that you are using to print labels
2 The supplier that produced your label sheets

3 The number that corresponds to the product number listed on your package of label sheets

Under Printer information, click the type of printer that you will use to print the labels.
In the Label vendors list, click the name of the company that made the label sheets that you are using.

In the Product number list, click the product number that is listed on the box of label sheets.
The product number for my label sheets doesn't match any of the choices in the Label Options dialog box

Measure the labels on the sheet you have, and note the measurements and how many labels

fit on a single sheet.

NOTE | Measure the labels carefully. The actual label size might be smaller than the size that is indicated

by the label manufacturer. For example, a 1-by-2-inch label might actually be 15/16-inch high and 1
15/16-inches wide.

In the Product number list, select a label type that is similar in size to your labels.

If you don't see the label type that you want in the Product number box, you may be able to use another

of the listed labels, or you can create a new label size.



3. Click Details, and then compare the label dimensions and the number of labels per sheet (for
labels printed on laser and ink-jet printers) or the number of columns on the label form (for labels printed

on dot-matrix printers).

4. Do one of the following:
. If the dimensions and label layout match those of your labels, use the selected
label.
. If the dimensions and layout do not match yours, click Cancel, and continue to
step 5.
5. In the Label Options dialog box, click the printer type (either Continuous-feed printers or

Page printers), and then click New Label.

6. Type a name in the Label name box, select the height, width, margins, and other options for

your label, and then click OK.

The new label appears in the Product number box as Label name - Custom. The label is also placed in
the Other/Custom category. The next time you use your custom labels, be sure to select Other/Custom

in the Label vendors list.
After you select the label options that you want, click OK.

Word creates a document that contains the sheet of labels. Word uses a table to lay out the labels. If you don't
see lines separating the labels, click the Layout tab under Table Tools, and then in the Table group, click

View Gridlines.

Resume a mail merge

If you need to stop working on a mail merge, you can save the label main document and resume the merge later.
Word retains the data source and field information. If you were using the Mail Merge task pane, Word returns to your

place in the task pane when you resume the merge.
When you are ready to resume the merge, open the document.

Word displays a message that asks you to confirm whether you want to open the document, which will run an

SQL command.



Because this document is connected to a data source and you want to retrieve the data, click Yes. If you
were opening a document that you did not realize was connected to a data source, you could click No to

prevent potentially malicious access to data.
The text of the document, along with any fields that you inserted, appears.
Click the Mailings tab, and resume your work.
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To merge information into your labels, you must connect the labels to your address list, also known as a data source

or a data file. If you don't already have a data file, you can create one during the mail merge process.

IMPORTANT | If you use an existing list, make sure that it contains the information that you want to use, including all
the columns and the rows. You can make some changes during the merge, but you can't open your data source

separately during the merge. The merge process is easier if your data source is ready before you connect to it.

Choose a data file

On the Mailings tab, in the Start Mail Merge group, click Select Recipients.
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Do one of the following:

= Use Outlook Contacts If you want to use your Contacts list in Microsoft Office Outlook, click

Select from Outlook Contacts.

IMPORTANT | For more information about using the Contacts list, see Tips for working with Microsoft

Office Outlook Contacts list.

. Use an existing data source file If you have a Microsoft Office Excel worksheet, a
Microsoft Office Access database, or another type of data file, click Use Existing List, and then locate

the file in the Select Data Source dialog box.



For Office Excel, you can select data from any worksheet or named range within a workbook. For Office

Access, you can select data from any table or query that is defined in the database.

IMPORTANT | For tips on formatting the data in your Excel worksheet for mail merge, see Tips for

formatting data in Office Excel.

For another type of data file, select the file in the Select Data Source dialog box. If the file is not listed,
select the appropriate file type or select All Files in the Files of type box. In a mail merge, you can use

the following types of data files:

] Files from single-tier, file-based database programs for which you have installed
an OLE DB provider or ODBC driver (a number of which are included with 2007 Microsoft Office
system).

. An HTML file that has a single table. The first row of the table must contain

column names, and the other rows must contain data.

= Electronic address books:
Ll Microsoft Office Outlook Address Book
Ll Microsoft Schedule+ 7.0 Contact List
= Any similar address lists that were created with a MAPI-compatible

messaging system, such as Microsoft Office Outlook.

. A Microsoft Office Word document. The document should contain a single table.
The first row of the table must contain headings, and the other rows must contain the records that

you want to merge. You can also use a header source as a data source.

] Any text file that has data fields separated (or delimited) by tab characters, or

commas and data records separated by paragraph marks.

= Create a new data file in Word If you don't have a data file yet, click Type New List, and
then use the form that opens to create your list. The list is saved as a database (.mdb) file that you can

reuse. For more information, see Type a new list.

NOTE | If you installed 2007 Microsoft Office system (instead of installing Office Word 2007 by itself), you can also

use Microsoft Query to construct a query and retrieve the data you want from an external data source.

If you are ready to continue, go to the next step.



If you need more information, read on.

Tips for working with Microsoft Office Outlook Contacts list

Connecting to your Office Outlook Contacts folder is usually a straightforward process, but sometimes you may

encounter a problem. Here are solutions to common problems that you may encounter:

I can't find my Outlook Contacts folder to connect to it.
| get error messages about mail clients and tables.
| can't connect to an Outlook Contacts folder in Public Folders.

| want to use my Outlook Express address book as my Contacts folder, but | can't connect to it.

I can't find my Outlook Contacts folder

You may need to turn on the Show this folder as an e-mail Address Book property in Outlook, or you may need to

change your Outlook user profile.
Turn on the Show this folder as an e-mail Address Book property

In Microsoft Office Outlook, on the Go menu, click Contacts.
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Right-click the Contacts folder that contains the information that you want to use for a mail merge, and

then click Properties on the shortcut menu.
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On the Outlook Address Book tab, make sure that the Show this folder as an e-mail Address Book

check box is selected, and then click OK.

Back to Outlook tips

Change your Outlook user profile

An Outlook user profile is a group of e-mail accounts and address books. Usually you need only one profile, but if you
share your computer with other people or use different address books for different purposes, you can set up more
than one profile. If, when you start your mail merge, you are using a profile that doesn't include the Contacts folder

that you want to use, that folder won't be available.

To switch to a different user profile, just restart Outlook. When you are prompted for a profile, choose the profile that

includes the Contacts folder that you want to use in the mail merge.

If you aren't prompted for a profile and you know that you have more than one profile, you may want to set up Outlook
so that it prompts you. Here is how:

Exit Outlook.

In Control Panel, switch to Classic View, and then click Mail.

Click Show Profiles.



To be prompted to select a profile each time you start Outlook, click Prompt for a profile to be used,

and then click OK.

Back to Outlook tips

| get error messages about mail clients and tables

If you try to connect to your Contacts folder during a mail merge in Word and Outlook is not set up as your default e-

mail program in Windows Internet Explorer, you will get a message that says:

"Either there is no default mail client or the current mail client cannot fulfill the messaging request. Please run

Microsoft Office Outlook, and set it as the default mail client.”
To avoid getting this message during a mail merge, do the following:

Exit Word.
On the Internet Explorer Tools menu, click Internet Options, and then click the Programs tab.

Under E-mail, click Microsoft Office Outlook, and then click OK.
Start Word again, open your mail merge document, and connect to your Outlook Contacts folder.

Back to Outlook tips

| can't connect to an Outlook Contacts folder in Public Folders

If you start a mail merge in Word and try to connect to an Outlook Contacts folder in Public Folders, you get a

message that says:
"The operation cannot be completed because of dialog or database engine failures. Please try again later."
If you try again later, you get the same message.

To use a Public Folders Contacts folder as the data file for your mail merge, you have to start the mail merge from

within Microsoft Office Outlook.

Back to Outlook tips

| want to use my Outlook Express address book as my Contacts folder



You can't connect to this type of address book directly during a mail merge. Instead, export your Microsoft Outlook

Express address book as a .csv text file and then connect to it in that form.
Export your Outlook Express address book

Start Outlook Express.
On the File menu, point to Export, and then click Address Book.

In the Address Book Export Tool dialog box, click Text File (Comma Separated Values), and then

click Export.
In the Save exported file as box, type a file name for your exported file, and then click Browse.

In the Save As dialog box, in the Save in list, choose where you want to save the file, and then click
Save. It is handy to save data files in the My Data Sources folder in your My Documents folder. That is where

Word searches first for data files when you browse for them during a mail merge.
Click Next. Select the check boxes next to the fields that you want to export, and then click Finish.
NOTE| When you are deciding which fields to export, think about the form letters, e-mail messages, or labels
that you intend to create with the mail merge. For example, if you never include nicknames or personal Web
sites in your merged documents, don't export those fields.
When you receive the message that the export procedure is completed, click OK.
To close the Address Book Export Tool dialog box, click Close, and then exit Outlook Express.
When you are back in Word performing your mail merge and you come to the step where you connect to a data file,
click the Use an existing list option, and browse to locate the .csv file that you just exported. Before the file opens,

you may be asked to select which separator character will separate one column from another in your address list.

Click Comma, and then click OK.

Back to Outlook tips

Tips for formatting data in Office Excel

If your data file is an Office Excel worksheet that includes percentages, currency values, or postal codes, you can

preserve the numeric formatting of the data by using Dynamic Data Exchange (DDE) to connect to the Excel



worksheet from Word. For example, you can make sure a five-digit postal code of 07865 from your data file is not

displayed as the number 7865 (without the leading zero).

Before you connect to the worksheet, do the following in Word:

Click the Microsoft Office Button (91 , and then click Word Options.

Click Advanced.

Scroll to the General section, and select the Confirm file format conversion on open check box.
Click OK.

With the mail merge main document open, in the Start Mail Merge group on the Mailings tab, click

Select Recipients, and then click Use Existing List.
Locate the Excel worksheet in the Select Data Source dialog box, and double-click it.

In the Confirm Data Source dialog box, click MS Excel Worksheets via DDE (*.xlIs), and then click OK.
NOTE If you don't see MS Excel Worksheets via DDE (*.xlIs), select the Show all check box.

In the Microsoft Office Excel dialog box, for Named or cell range, select the cell range or worksheet

that contains the information that you want to merge, and then click OK.

NOTE| To prevent being prompted every time you open a data file, you can clear the Confirm conversion at

Open check box after you connect to the worksheet.

Type a new list

In the New Address List dialog box, type the information for the first address, or record, that you want to

include in your label merge.
If you want to add or remove columns, click Customize Columns, and then make the changes that you want.

After you type all the information for your first record, click New Entry, and then type the information for
the next record. Continue until you have typed information for all the records that you want to include.

When your new list is complete, click OK.

In the Save Address List dialog box, type a name for your new list, and then click Save.
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When you connect to a certain data file, you might not want to merge information from all the records (rows) in that

data file into your labels.
If you plan to use your entire list, you can skip ahead to the next step.
To narrow the list of recipients or use a subset of the items in your data file, do the following:

On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.
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In the Mail Merge Recipients dialog box, do any of the following:

. Select individual records This method is most useful if your list is short. Select the check
boxes next to the recipients you want to include, and clear the check boxes next to the recipients you

want to exclude.

If you know that you want to include only a few records in your merge, you can clear the check box in the
header row and then select only those records that you want. Similarly, if you want to include most of the
list, select the check box in the header row, and then clear the check boxes for the records that you don't

want to include.

. Sort records Click the column heading of the item that you want to sort by. The list sorts in
ascending alphabetical order (from A to Z). Click the column heading again to sort the list in descending

alphabetical order (Z to A).

If you want more complex sorting, click Sort under Refine recipient list and choose your sorting
preferences on the Sort Records tab in the Filter and Sort dialog box. For example, you can use this
type of sorting if you want recipient addresses to be alphabetized by last name within each postal code

and the postal codes listed in numerical order.

. Filter records This is useful if the list contains records that you know you don't want to see
or include in the merge. After you filter the list, you can select or clear the check boxes to include or

exclude records.



To filter records, do the following:

1. Under Refine recipient list, click Filter.

2. On the Filter Records tab in the Filter and Sort dialog box, choose the criteria

that you want to use for the filter.

For example, to generate labels only for addresses that list Australia as the country/region, you
click Country or Region in the Field list, Equal to in the Comparison list, and Australia in the

Compare to list.

3. To refine the filter further, click And or Or and choose more criteria.

For example, to generate labels only for businesses in Munich, you filter on records whose City
field contains Munich and whose Company Name field is not blank. If you use Or instead of And
in this filter, your mail merge includes all Munich addresses as well as all addresses that include a

company name, regardless of city.

. Add recipients To add recipients to the list, do the following:
1. On the Mailings tab, in the Start Mail Merge group, click Edit Recipient List.
2. Under Data source, click the name of your data file.
3. Click Edit.
4. In the Edit Data Source dialog box, click New Entry, and then type the

information for that recipient.

TIP, Depending on the type of data source that you use, some processes might not be available. If

possible, make sure that your data file is complete before you connect it to your label main document.

NOTE| If you have installed address validation software, you can click Validate addresses in the Mail Merge

Recipients dialog box to validate your recipients' addresses.

& Top of Page



After you connect your labels to your address list, you are ready to add placeholders that indicate where the
addresses will appear on each label. You can also type text that you want repeated on each label, such as a

company logo or your return address on a shipping label.

If you are familiar with how mail merge fields work, you can skip ahead to mapping and merging.

If you want to learn more about how mail merge fields work, read on.

The placeholders for the addresses are called mail merge fields. Fields in Word correspond to the column headings

in the data file that you choose.

[ &0 ® [ <
Mame Last Name Street Address

Marcy Ancersan 123 Main St.
FoaTal Beehe 567 Country Rd. 2'
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1 Columns in a data file represent categories of information. Fields that you add to the labels are placeholders for

these categories.

2 Rows in a data file represent records of information. Word generates a label for each record when you perform a

mail merge.

By putting a field in the initial label that you set up (your label main document), you indicate that you want a certain

category of information, such as name or address, to appear in that location.

«Address Block:»




NOTE| When you insert a mail merge field into the label main document, the field name is always surrounded by
chevrons (« »). These chevrons do not show up on the final labels. They just help you distinguish the fields in the

label main document from the regular text.

What happens when you merge

When you merge, information from the first row in the data file replaces the fields to create the first label. Information

from the second row in the data file replaces the fields to create the second label, and so on.

A | B ] c |
Name | [Last Name | [Street Address |
Mancy aAnderson 123 Main St
Arin Beehe 567 Country Rd.

NG

Fancy Anderson
123 Main Sk,
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Working with fields: Examples

You can add any column heading from your data file to the label as a field. This gives you flexibility when you design

labels.

For example, suppose your mailing list is for subscribers to your newsletter, and your data file includes a column,
called ExpireDate, for storing the date that each subscription expires. If you place an «ExpireDate» field in the label

main document before you run the merge, subscribers will each see their own expiration date on their mailing label.

You can combine fields and separate them with punctuation marks. For example, to create an address, you can set

up the fields in your label main document like this:
«First Name» «Last Name»

«Street Address»

«City», «State» «Postal code»

For things that you use frequently, like address blocks and greeting lines, Word provides composite fields that group
a number of fields together. For example, the Address Block field is a combination of several fields, including first

name, last name, street address, city, and postal code.



Mancy Anderson
«Address Block» 4 123 Main St.

Belingham, WA 14456

You can customize the content in each of these composite fields. For example, in the address, you may want to

select a formal name format (Mr. Joshua Randall Jr.). In the greeting, you may want to use "To" instead of "Dear."

Map the mail merge fields to your data file

To make sure that Word can find a column in your data file that corresponds to every address element, you may need

to map the mail merge fields in Word to the columns in your data file.

To map the fields, click Match Fields in the Write & Insert Fields group on the Mailings tab.

= EEE
< 5 Match Fields

Highlight Address Greeting Insert Merge
Merge Fields Block Line Field 2] Update Labels
Write & Insert Fields

The Match Fields dialog box opens.

Match Fields

In order to use special Features, Mail Merge needs
ko know which fields in vour recipient list match

ko the required fields, Use the drop-down lisk to
select the appropriate recipient list Field For each
address field component

Unique Identifier [(not matched)  »| A
Courtesy Title ||:n|:-t matched) V|
First Narme |{rok makched) |
Middle: Marme [(not matched) |
Last Marne | Surnare w|

The elements of an address are listed on the left. Column headings from your data file are listed on the right.

Word searches for the column that matches each element. In the illustration, Word automatically matched the data
file's Surname column to Last Name. But Word was unable to match other elements. From this data file, for

example, Word can't match First Name.



2.

In the list on the right, you can select the column from your data file that matches the element on the left. In the
illustration, the Name column now matches First Name. It is okay that Courtesy Title, Unique Identifier, and
Middle Name aren't matched. Your mail merge label doesn't need to use every field. If you add a field that does not
contain data from your data file, it will appear in the merged document as an empty placeholder — usually a blank

line or a hidden field.

Match Fields

In order to use special Features, Mail Merge needs
ko know which fields in vour recipient lisk match

ko the required fields, Use the drop-down lisk ko
select the appropriate recipient list Field For each
address field component

Unique Identifier [(not matched)  »| A
Courtesy Title ||:n|:-t matched) V|
First Mame | Mame bl |
Middle: Marme [(not matched) |
Last Marne | Surnare w|

Type the content and add the placeholders, or fields

In the initial label that you set up (your label main document), type any content that you want to appear

on every label.
To add a picture, such as a logo, click Picture in the lllustrations group on the Home tab.

Click where you want to insert the field.

Use the Write & Insert Fields group on the Mailings tab.

S R B = B
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Add any of the following:
Address Block with name, address, and other information

1. Click Address Block.

2. In the Insert Address Block dialog box, select the address elements that you want to

include and the formats you want, and then click OK.



3. If the Match Fields dialog box appears, Word may have been unable to find some of the
information that is required for the address block. Click the arrow next to (not matched), and then select

the field from your data source that corresponds to the field that is required for the mail merge.

Individual fields

4. On the Mailings tab, in the Write & Insert Fields group, click Insert Merge Field.
5. In the Insert Merge Field dialog box, do one of the following:
. To select address fields that will automatically correspond to fields in your data

source, even if the data source's fields don't have the same names as your fields, click Address

Fields.

] To select fields that always take data directly from a column in your data file, click

Database Fields.

6. In the Fields box, click the field that you want.
7. Click Insert, and then click Close.
8. If the Match Fields dialog box appears, Word may have been unable to find some of the

information required to insert the field. Click the arrow next to (not matched), and then select the field

from your data source that corresponds to the field that is required for the mail merge.

Custom fields from Office Outlook contacts

9. In Outlook Contacts, on the View menu, point to Current View, and then click Phone List.
10. Right-click a column heading, and then click Field Chooser on the shortcut menu.
11. In the drop-down list at the top of the Field Chooser dialog box, select User-defined fields

in folder.
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14.

15.

16.

17.

18.

19.

20.

21.

Drag the field that you to add from the dialog box to the column headings. A little red arrow

helps you place the field in the location that you want.
Customers

First ... | Last Name| Faumtilﬂ_oast [

Click ... | | L
el foid Cooser 11

Ann Beebe :
Richard | Carey ILIser-dEﬁned fields in folder j

Wilis  |Johnson
Sunil Koduri

NOTE | You can add a new field in the Field Chooser dialog box by clicking New at the bottom.

After you add all of your custom fields to the view, close the Field Chooser dialog box.

To remove a field that you do not want included in the mail merge, click the field name in the

column heading in Phone List view, and drag it off the column heading.

In Outlook Contacts, select individual contacts by holding down SHIFT and clicking to select
a range or by holding down CTRL and clicking to select individuals. If you want to include all the contacts

currently visible in the view, do not click any contacts.
On the Tools menu, click Mail Merge.

If you selected individual contacts to include in the mail merge, click Only selected
contacts. If you want to include all the contacts that are currently visible in the view, click All contacts in

current view.

If you configured the Phone List view so that it displays exactly the fields that you want to use
in the mail merge, click Contact fields in current view. Otherwise, click All contact fields to make all of

the contact fields available in the mail merge.

If you want to generate a new main document for the mail merge, click New document.
Otherwise, click Existing document, and then click Browse to locate the document to use as the main

document.

If you want to save the contacts and fields that you selected so that they can be reused,
select the Permanent file check box, and then click Browse to save the file. The data is saved in a

Word document as comma-delimited data.

Select Mailing Labels.



22. Click OK. When the document opens in Word, on the Mailings tab in the Write & Insert
Fields group, click the arrow next to Insert Merge Field, and then click the fields that you want to add to

the label main document.

When you finish setting up the first label the way you want it, in the Write & Insert Fields group, click

Update Labels.
The content of the first label is replicated to all the other labels.

NOTES

You can't type merge field characters («« »») manually or use the Symbol command on the Insert menu.
You must use mail merge.
If the merge fields appear inside braces, such as { MERGEFIELD City }, Word is displaying field codes

instead of field results. This doesn't affect the mail merge, but if you want to display the results instead, right-

click the field code, and then click Toggle Field Codes on the shortcut menu.

Format the merged data

Database and spreadsheet programs, such as Microsoft Office Access and Microsoft Office Excel, store the
information that you type in cells as raw data. Formatting that you apply in Access or Excel, such as fonts and colors,
isn't stored with the raw data. When you merge information from a data file into a Word document, you are merging

the raw data without the applied formatting.
Add formatting

Select the mail merge field. Make sure that the selection includes the chevrons (« ») that surround the
field.

On the Home tab, in the Font group, apply the formatting that you want. Or click the Font Dialog Box

launcher for more options.

IMPORTANT| To minimize the extra space between lines in the addresses on your labels, you must select the lines,
click the Paragraph Dialog Box launcher on the Home tab, and then type 0 in the before and after spacing boxes. If
you are using the Address Block merge field, select the whole field, including the chevrons (« »), and then adjust the

spacing.
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After you add the fields to the initial label that you set up (label main document), you are ready to preview the mail

merge results. When you are satisfied with the preview, you can complete the mail merge.

Preview the merge
You can preview your labels and make changes before you actually complete the mail merge.

To preview, do any of the following in the Preview Results group of the Mailings tab:

m&{ {4 | b M|

i Find Recipient

Preview
Results | =+ Auto Check for Errors

Preview Results

Click Preview Results.

Page through each label by clicking the Next Record and Previous Record buttons in the Preview

Results group on the Mailings tab.

Preview a specific document by clicking Find Recipient.

NOTE  Click Edit Recipient List in the Start Mail Merge group on the Mailings tab to open the Mail Merge

Recipients dialog box, where you can filter the list or clear recipients if you see records that you don't want to

include.
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Merge = Recipients = Recipient List
Start Mail Merge

NOTE| Word uses a table to lay out a sheet of labels on the page. As you page through the labels, the active record
is displayed in the first cell of the table, with the following records displayed in subsequent cells. This method of
display may give you the impression that Word will generate a sheet of labels for each record in the data file, but that

is not the case.

Complete the merge

You can print the labels or modify them individually. You can print or change all or just a subset of the labels.



If you want to print a subset of the labels, you can specify the set by a range of record numbers. If you want to print

pages instead of specifying record numbers, follow the instructions in the Change individual labels section.

Print the labels

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Print Documents.
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2. Choose whether to print the whole set of labels, only the label that is currently visible, or a subset of the

set, which you specify by record number.
Change individual labels

1. On the Mailings tab, in the Finish group, click Finish & Merge, and then click Edit Individual

Documents.
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Merge
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2. Choose whether you want to edit the whole set of labels, only the label that is currently visible, or a

subset of the set, which you specify by record number. Word saves the labels that you want to edit to a single

file.

After you finish editing the new file of labels, you can print the labels by clicking the Microsoft Office Button
D

= and then clicking Print.

Save the label main document

Remember that the merged labels that you save are separate from the initial label that you set up (the label main

document). It is a good idea to save the label main document itself if you plan to use it for another mail merge.



When you save the label main document, you also save its connection to the data file. The next time that you open
the label main document, you are prompted to choose whether you want the information from the data file to be

merged again into the label main document.

If you click Yes, the document opens with the information from the first record merged in.

If you click No, the connection between the label main document and the data file is broken. The label
main document becomes a standard Word document. Fields are replaced with the unique information from the

first record.



